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PowerMILL is the leading specialist NC CAM software for 
manufacturing complex shapes typically found in the toolmaking, 

automotive, and aerospace industries. PowerMILL 2011 offers all of 
the original features of PowerMILL 2010, but with numerous 

improvements. The most significant improvements are described in 
this document. 

 

Toolpath preparation 
There is an additional option on the Create Boundary dialogs  which 

determines whether the tool, and therefore the boundary, is allowed 
outside the block (see page 4). 

There are improvements to shallow boundaries (see page 4). 

There are several improvements to the Curve Editor toolbar (see 

page 6). 

 You can now create an arc which is tangential to existing lines 

and arcs as well as at specific points using the Arc 3 Items   

button (see page 12). 

 Fillets can now be modified in two ways (see page 13). 

 You can now create a line which is tangential to a curve (see 

page 6). 

 There are four new options on the Transformation toolbar. 

  Offset (see page 16) - offsets curve by a specified distance. 

  Multiple transformation (see page 23) - an easier method of 

performing multiple Moves  or Rotations . 

  Transform to workplane (see page 6) - moves the curves so 

they are in the same place relative to the active workplane as 
they were to the global transform. 

Summary of new features 
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  Transform to world (see page 6) - moves the curves so they 

are in the same place relative to the global transform as they 

were to the active workplane. 

 There is an additional limit option on the Limit toolbar of  Limit 

to intersection which limits the curve to the nearest intersection 

point (see page 33). 

 Many of the curve editor options, such as creating a continuous 
line, are much faster. This is particularly noticeable when the 

view contains a large model, toolpath, or stock model. 

 There is now a Properties option which displays the extents of the 

curves and specifies the number of segments in the entity (see 

page 6). 

 Insert Point  has an additional option of Between points (see 

page 34). 

There are no longer any restrictions on tool holder and shank 
component geometry (see page 34). 

The Tool Database Search dialog now displays the name of the 

current tool database (see page 38). 

There are two new options on the Block dialog which allow you to: 

 Include a reference model when calculating the extents of the 
block (see page 39). 

 Save a block (see page 38). 

There is a new option which determines how to align a workplane 

(see page 42). 
 

Toolpath generation 
There is a new page on the finishing strategy dialogs of Stock 

Engagement that avoids machining too far into the stock material 

and removes toolpath segments that don't machine the stock (see 

page 43). 

Limiting toolpaths to a 3D boundary uses a new algorithm and 

produces much better results (see page 52). 

There is a new Fixed Angle frame on the Tool Axis dialog  (see 

page 53). 

Using the new Lead feed rates page, you can specify the Ramp lead 

in, Lead in, and Lead out feed rates for lead moves as a factor of the 

cutting feed rate (see page 56). 



 

PowerMILL 2011 What's New Summary of new features • 3  

The toolpath transformation functionality is improved to make it 

easier to use (see page 57).  

There is an additional option of Draw Cutting Moves  on the 
drawing and viewing options on the Toolpath toolbar (see page 81). 

Profile area clearance strategies have an additional option of 
Additional profiles on the Cut direction frame (see page 82).  

Blisk machining can now machine hubs that bend upwards at their 

ends (see page 83). 

There are several general toolpath enhancements (see page 84). 
 

Toolpath verification 
Some new parameters are displayed in the Post-Creation Verification 

part of the toolpath tree (see page 86). 
 

User interface 
The new Selection dialog makes it easier to select individual model 

components by Model, Colour, and Levels and Sets. The selection 

settings are stored in the toolpath template, allowing you to export 
and import the selection settings into a different PowerMILL project 

(see page 87). 

You can now display the tool shank and holder as well as the tool 

tip. This improves the ability to do a visual check of the tool against 

the part (see page 88). 

To avoid duplication, options available on the Curve editor toolbar 

are no longer available on the explorer context menus (see page 
88). 

To make it easier to visualise the principal editing plane, the normal 
is displayed in a different colour on the active axes (see page 89).  

 

General enhancements 
You can now change the Orientation Vector Length (see page 90). 
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Boundary improvements 
There are a few enhancements to boundaries: 

 There is a new option on the Create Boundary dialogs which 

determines whether the tool, and therefore the boundary, is 
allowed outside the block (see page 4).  

 Faster creation of shallow boundaries. 

 You can now create a shallow boundary on a surface which has a 

negative thickness. 
 

Boundaries outside block 

There is an additional option on the Create Boundary dialogs (which 

are created using a tool) of Block Limit. This determines whether the 

tool, and therefore the boundary, is allowed outside the block. 
Previously all boundaries were contained within the block. This 

enhancement improves consistency between boundary and toolpath 

creation. 

 

 - allows the tool outside the confines of the block. It can only 

extend outside the block by up to one tool radius. 

 - the tool tip is contained within the block. 

 If there is an active toolpath, then when you create a new 

boundary, the boundary block limit is set to the same value 

(centre  or periphery ) as the toolpath block limit. The 
two values are not locked though, so you can set one to tool 
centre and the other to tool periphery. 

Toolpath preparation 
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This example uses a selected surface boundary, but other 
boundaries work in the same way. It uses the cowling.dgk model in 
the Examples folder. 

 

Creating a selected surface boundary with a Block Limit of  

gives: 

 

You can see the boundary extends beyond the edge of the block. 

Looking at the ISO view: 
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Creating a selected surface boundary with a Block Limit of  

gives: 

 

You can see the boundary never goes outside the block. 

Looking at the ISO view: 

 

You can see the boundary rises up the model to ensure the tool is 

contained within the block. 
 

Curve editor improvements 
 

There are several improvements to the Curve Editor toolbar. These 

reduce the need to use PowerSHAPE or other third party CAD 
systems to generate complex wireframe geometry for machining. 

 You can now create an arc which is tangential to existing lines 

and arcs as well as at specific points using the Arc 3 Items  

button (see page 12). 
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 Fillets (see page 13) can now be modified in two ways: 

1 As a fillet - Changing the radius of the fillet and re-trimming 
the entities at either end of the fillet. 

2 As an arc - Moving the origin of the fillet, but maintaining the 
radius. The trimmed entities remain unchanged. This was the 

only option in previous versions. 

 You can now create a line which is tangential to a curve. The first 

point snaps to the arc tangent. The length and angle of the line 
are displayed as you move the cursor to select the second point. 

The resulting line is always tangent to the arc. 

 

 There are four new options on the Transformation toolbar . 

  Offset (see page 16) - offsets the curve by a specified 

distance. 

  Multiple transformation (see page 23) - an easier method of 

performing multiple Moves  or Rotations . This is similar 

to Multiple transformations of toolpaths (see page 63). 

  Transform to workplane - moves the curves so they are in 

the same place relative to the active workplane as they were 

to the global transform. 

Converts this: 
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to this: 

 

  Transform to world - moves the curves so they are in the 

same place relative to the global transform as they were to 
the active workplane. 

Converts this: 

 

to this: 

 

 There is an additional limit option on the Limit toolbar . 

  Limit to intersection (see page 33) - limits the curve to the 

nearest intersection point. The portion of the curve you select 

is the portion of the curve that is removed. 



 

PowerMILL 2011 What's New Toolpath preparation • 9  

 The pattern projections options are now available on the Curve 

Editor toolbar  as well as from the individual pattern context 

menu. 

  Drop - the selected pattern is projected down the tool axis 

(or dropped) onto the part. The whole pattern must be 
contained within the part when viewed down the tool axis. 

 

 - original pattern. 

 - pattern dropped on to the part. 

  Flatten - the selected pattern is projected (or flattened) 

onto the XY plane at Z = 0. In this case the pattern need not 
be entirely contained within the part. 

 

 - original pattern. 

 - patten flattened onto Z=0. 

  Embed - links the pattern lying on the model to its 

associated surface (or surfaces).  
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This displays the following dialog: 

 

Method - defines how the pattern is associated to the surfaces. 

Closest Point - the points on the curve are associated to the 

closest point on the surfaces provided it is within the Embedded 

Distance. 

Drop - the curve is projected down Z Axis of the active workplane 

(or dropped) onto the part. The whole curve must be contained 
within the part when viewed down Z. If the Closest Point method 

doesn't work you may find that this option does. 

Embedded Distance - defines the maximum distance the curve can 

be to the surface to enable embedding to take place. If the 
Embedded Distance is exceeded you get the following error 

message: 

 

In this case you may find choosing a Method of Drop cures the 

problem. 

Tolerance - defines the tolerance used when Embedding Patterns. 

For more information on embedded patterns see the Example 

Creating an Embedded Pattern. 

 By default the pattern is embedded onto all the surfaces in 
the model. However, if you select one or more surfaces, then 

the curve will only be embedded onto the selected surfaces. 

 Many of the curve editor options, such as creating a continuous 

line, are much faster. This is particularly noticeable when the 
view contains a large model, toolpath, or stock model. 
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 There is a Properties option on the Curve editor menu which 

displays the extents of the curves and specifies the number of 
segments in the entity.  

 

 

Pattern - the name of the pattern, in this case Input curves. 

Segment - displays the properties of the segment listed here, in this 

case the fifth segment. 

 Insert Point  has an additional option of Between points (see 

page 34). 
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Creating an arc using three items example 

This example shows you how to create an arc tangential to other 

items. It starts with a simple line, arc, and circle. 

 

1 Click the Arc 3 Item  button from the Circles pull-out toolbar 

. 

2 Select the line to indicate the start point of the arc (point ). 

3 Select the circle to indicate the end point of the arc (point ). 

4 Select the arc to indicate a mid-point of the arc (point ). 

 

PowerMILL creates an arc which is tangential to all three items. 
and displays the Arc Confirm dialog. 
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5 Since there are many solutions, PowerMILL supplies one, but 
allows you to choose another by clicking Next solution. 

6 When you are happy with the solution, click OK. 

 

Only items at the start or end are trimmed (or extended), the 

middle item is never trimmed (or extended). Open curves (arcs 
and lines) can be trimmed, but closed curves (circles) are never 

trimmed. 

 Pressing the Shift key whilst selecting the third item 

suppresses trimming (or extending) of the start and end item. 

 

For more information, see the creating an arc with three points and 
creating circles and arcs examples. 

 

Changing the radius of a fillet example 

This example shows you how to edit a fillet. It starts with a simple 
line and fillet. 
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1 Click the Fillet  button from the Circles pull-out toolbar . 

2 In the Fillet toolbar, enter a Radius of 8. 

 

3 Select the arc and the line to indicate the location of the fillet. 

 

4 Click  to close the Fillet toolbar. 

5 Select the fillet to edit it. 

 

6 Select the blue arrow and drag it to the right. 

 

The fillet radius is reduced and the line and arc next to the fillet 

are re-trimmed. 
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7 Select the blue arrow and drag it to the left. 

 

The fillet radius increases, the location of the centre of the fillet 
moves, and the line and arc next to the fillet are re-trimmed. 

8 Double click on the fillet to display the Arc Editor dialog. 

 

9 In the Arc Editor dialog enter a Radius of 8. 

 

10 In the Arc Editor dialog, Lock  the Centre. 

11 Select the blue arrow and drag it to the right. 

 

The fillet radius increases, the location of the centre of the fillet 
stays in the same place, and the line and arc next to the fillet 

remain unchanged. 
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Offset curve 

 

 Offset type - determines the offset type. A positive value offsets 

the curve outwards, a negative value offsets the curve inwards. 

 2D round - offsets a 2D curve by a specified distance. This 

creates smooth offsets when offsetting outwards and sharp 

offsets on internal corners when offsetting inwards. This is the 
same as Edit > Offset 2D (Round corners) on the individual 

boundary context menu.  

If you start with this curve: 

 

Selecting  2D round gives you: 
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 - original curve. 

 - curve offset inwards. 

 - curve offset outwards. 

This creates smooth offsets when offsetting outwards and sharp 

offsets on internal corners when offsetting inwards. 

 2D Sharp - this is similar to 2D Round  except the offset 

curve has sharp offsets on external corners when offsetting 

outwards and sharp offsets on internal corners when offsetting 
inwards. This replaces Edit > Offset 2D (Sharp) on the individual 

boundary context menu.  

If you start with this curve: 

 

Selecting the  2D Sharp gives you: 
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 - original curve. 

 - curve offset inwards. 

 - curve offset outwards. 

This option creates sharp offsets on external corners when 

offsetting outwards and sharp offsets on internal corners when 
offsetting inwards. 

 3D Round - this is similar to 3D Smooth  except the offset 

curve isn't necessarily smoothed. This creates smooth offsets 
when offsetting outwards and sharp offsets on internal corners 
when offsetting inwards. This replaces Edit > Offset 3D (Round 

corners) on the individual boundary context menu.  

Starting with 5axisModel.dgk in the examples file with a selected 

surface boundary: 

 

Selecting  3D Round and a Distance of -10 gives you: 
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This creates smooth offsets when offsetting outwards and sharp 

offsets on internal corners when offsetting inwards. 

 

 - original curve. 

 - curve offset inwards. 

 - curve offset outwards. 

 3D Smooth - offsets a 3D curve by a specified distance. This 
always creates smooth offsets. This replaces Edit > Offset 3D 

(Smooth) on the individual boundary context menu.  

Starting with 5axisModel.dgk in the examples file with a selected 

surface boundary: 
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Selecting  3D Smooth and a Distance of -10 gives you: 

 

This option always creates smooth offsets. 

 

 - original curve. 

 - curve offset inwards. 

 - curve offset outwards. 

 Concentric curves - determines whether concentric curves are 

offset by region or as individual curves. 
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 Offset concentric curves by region - concentric curves are 

treated as regions and are offset outside, or inside the region. 

Starting with this: 

 

Selecting  offsets the curve outside the region: 
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 Offset curves individually - concentric curves are treated as 

individuals and are offset individually. 

Starting with this: 

 

Selecting  offsets each curve outwards: 

 

 Keep Original - determines whether the entities are copied or 

replaced when transformed. 

 Replace Original - the original entities are replaced with the 

transformed ones. 

 Keep Original - keeps both the original and transformed 

entities. 

No. of Copies - the number of copies you want. 

Distance - the offset distance. 
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Multiple transform (curve) 

 Multiple transform is an easier method of performing multiple 

Moves  or Rotations  of curves. It is available from the Curve 

Editor toolbar. 

 

This works in the same way as  Multiple transform on the Toolpath 

toolbar except it works on curves rather than toolpaths (see page 

63). 

The orientation of the transform is determined by the principal 

working plane , , or , set in the Information toolbar. 

For information on the Circular tab, see Multiple transform - Circular 

(see page 27). 

The examples use the chainsaw.ige model in the examples file with 

a selected surface boundary. 

 Number of rows - either enter a value or use  . 
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This curve transform has 3 rows and 4 columns: 

 

 Distance between rows - by default, this specifies the extents 

of the curve. 

 Rotate axis - rotates the transform by 90  in a clockwise direction 

in the principal working plane. 

Converts this: 
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to this: 

 

 Move Origin - when selected, enables you to move the origin 

graphically, by dragging, or by entering coordinates using , , 

or  and  in the Status bar. 

 Distance between columns - by default, this specifies the 

extents of the curve. 

 Number of columns - either enter a value or use  . 

This curve transform has 3 rows and 4 columns: 

 

Hollow box - places the duplicated curves around the perimeter of 

the transform and removes the central ones. 
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Converts this: 

 

to this: 

 

For more information, see Rectangular transform example (see 

page 78); this example shows you how to create multiple moves on 
a toolpath using a rectangular pattern, but the principle is the same 

for curves. 
 



 

PowerMILL 2011 What's New Toolpath preparation • 27  

Multiple Transform - Circular (curve) 

The Circular tab on the Multiple Transform dialog creates multiple 

Rotations of curves. 

 

This works in the same way as the Circular tab (see page 68) on the 

Multiple transform on the Toolpath toolbar (see page 63) except it 

works on curves rather than toolpaths. 

The orientation of the transform is determined by the principal 

working plane , , or , set in the Information toolbar. 

 Angle - the angle between elements in the transform. You 
can also use the slider, or specify the Number of elements to 

determine the angle. 

 Angle lock - determines whether the rotation angle is calculated 

automatically or not. 



 

28 • Toolpath preparation PowerMILL 2011 What's New  

 Calculated - the values are calculated automatically by 

PowerMILL. This assumes that you want a full circular pattern 
(Angle = 360/Number).  

 Edited - the value is entered by you (or another user). The 

Angle and Number values operate independently. This enables 

you to create a partial circle rather than a full circular pattern. 

  and  work as a toggle.  

 Radius - the radius of the pattern. You can also use the slider 

to determine the radius. 

 Radius lock - determines whether the rotation radius is defined 

automatically or not. 

 Calculated - the values are calculated automatically by 

PowerMILL. The radius is the distance from the centre of the 

rotation (defined by ) to the centre of the set of curves. 

 Edited - the value is entered by you (or another user). 

 Clockwise - rotates the transform clockwise by half of the Angle. 
Clicking this updates the Offset angle. 

Original transform: 
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Clicking  changes it to: 

 

and updates Offset angle to -45 . 

 Anticlockwise - rotates the transform anticlockwise by half of the 
Angle. Clicking this updates the Offset angle. 

 Number - the number of entities in the circular pattern. If 

the angle lock is , then editing this field edits the angle. If the 

angle lock is  then Angle and Number work independently. 

It is best to see how these fields interact by example. If you have: 

 An Angle of 60  

  selected. 

PowerMILL calculates the Number automatically (it is 6). 

 

If you have: 

 A Number of 5 

  selected. 
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PowerMILL calculates the Angle automatically (it is 72 ). 

 

If you have: 

 An Angle of 60  

  selected 

 A Number of 5. 

PowerMILL calculates a partial circular pattern. 

 

Offset angle - determines the start angle of the transform. 
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Offset angle of 0 : 

 

Offset Angle of 20 : 

 

Rotation - determines whether you rotate or move the curves 

around the transform. 

 Rotate and copy: 

 



 

32 • Toolpath preparation PowerMILL 2011 What's New  

 Rotate and move: 

 

Centre element - creates an additional copy of curves at the centre of 

the circle. 

Centre element selected: 

 

Centre element deselected: 

 



 

PowerMILL 2011 What's New Toolpath preparation • 33  

For more information, see Circular transform example (see page 

80). This shows how to create multiple rotations on a toolpath using 
a circular pattern, but the principle is the same for curves. 

 

Limit to intersection example 

This example shows you how to limit two intersection curves. It 
assumes that you have created two intersecting curves, using the 
Curve Editor toolbar.  

 

1 Click the Limit to Intersection  button from the Limit pull-out 

toolbar .  

2 Select the portion of the curve you want to remove. 

 

The curve you hover over turns red. 

Selecting the curve limits it back to the nearest intersection 
point. 

 

3 Select the second portion of the curve you want to remove. 

 

Selecting the curve limits it back to the nearest intersection 

point. 

 

4 Repeat for the remaining two "tails". 
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Insert Point into Curve dialog 

There is an additional way of inserting points into a curve using 

Insert Point  on the Curve Editor dialog of equispaced between 

two consecutive points. 

 

For example, to insert points in to this curve: 

 

1 Select the curve. 

2 On the Curve Editor toolbar, click  to display the Insert Point 

Into Curve dialog. 

3 Select the Between points tab and enter a Number of points of 3. 

4 On the curve, select points 2 and 3. 

 Press the Shift key on your keyboard to select multiple 
points. 

5 Click Apply and Close. 

 

The additional points are inserted into the curve. 
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Tool component geometry 
The introduction of the tool holder profile functionality in PowerMILL 
2010 has made the restrictions on tool profile, tool holder, and 

shank component geometry unnecessary. Now you have fast and 
easy construction of accurate and complex tool assemblies using 

either the curve editor or importing profiles. 

 Tool profiles with any shape may be loaded with any type of file 

format. 

 You can create a tool profiles using the curve editor. 

 You can create tool profiles from arcs, curves, lines, or other dgk 
curves. 

 You can create tool profiles from patterns.  

 The resulting curve doesn't have to be one single composite 

curve.  

 As long as the geometry contains a valid profile, PowerMILL will 

import the components. 

 Tool profiles containing negative Y moves are imported, but the 
negative moves are ignored. 

 Gaps between curves in the tool profile must be less that 10-5 

mm. 

 The tool profile is a polygonised approximation of the input 
profile. 

In previous versions, imported tool shank and tool holder geometry 
suffered from the same restrictions as form tools: 

 Only .dgk files could be imported. 

 The curve could only contain lines or arc spans. 

 All lines and arc spans had to be concatenated to form one 
composite curve. 

These restrictions were in place so as not to impact on collision 

checking performance. The tool holder profile functionality 
supersedes this requirement. 

 

Creating a tool shank from a pattern 

This example shows you how to create a shank for a specific tool. 
The shank profile is generated outside PowerMILL and imported as a 

pattern. You can create a form tool profile, routing tool profile, and 
tool holder in the same way.  
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Creating a pattern 

1 Click Create Pattern  on the Pattern toolbar to create a new 

pattern. 

2 Click Insert File into Active Pattern  on the Pattern toolbar. this 
displays the Open Pattern dialog. 

3 Click  to display the Examples file and then click on the 
Patterns folder. 

4 Select sample_shank.dgk and click Open. 

 

Creating the shank 

1 From the individual tool context menu, select Settings. 

2 Select the Shank tab from the Tool dialog. 
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3 Click Pick a Pattern  and then select the pattern you have just 

created. 

4 Click the Create shank from pattern button. The shank is added to 

the tool tip. 

 

 Since tool shanks can't contain negative Y moves, PowerMILL 

removes them from the pattern when creating the shank. 

 

 Pattern with negative Y move. 

 Shank created from the pattern with only positive Y 

moves. 
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Tool database enhancements 
Searching the database for tools which use stock materials is much 
faster. 

The Restore Defaults button on the Options dialog (available from 
the Tool > Options menu) restores the default tool database. 

The Tool Database Search dialog now displays the name of the 

current tool database. This makes it easier to see the current tool 
database and so minimise errors from using the wrong tool 

database. Previously, this was only available if you hovered the 
mouse on the title of the Tool Database Search dialog. 
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Block enhancements 

There are two new options on the Block  dialog which allow you 

to: 

 Include a reference model when calculating the extents of the 
block (see page 39).  

 Save a block. 

 

 Save Block enables you to export the block as a *.dmt or *.stl file. 
 

Creating a block using a reference surface 

There is a new option on the Block  dialog, which allows you to 

include a reference model when calculating the extents of the block. 
This is particularly useful when creating a surface projection 

toolpath where the reference surface is larger than the model. 

This example shows the effect of using a reference surface when 
creating a block. It uses the Hub.dgk example in the Examples file. 

 

1 From the Models context menu, select Import Reference Surfaces. 
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2 Open the RefSurface.dgk model in the Examples file. 

 

3 Click  on the Main toolbar to open the Block dialog. 

 

a Set Defined by to Cylinder. 

b Deselect Include reference surfaces. 

c Select Draw. 
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d Click Calculate. 

 

 - block excluding reference surface. 

4 In the Block dialog: 

a Select Include reference surfaces. 

b Click Calculate. 

 

 - block including reference surface. 
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Workplane alignment 
There is a new Tools > Options > Workplane > Creation option, which 

determines how to align a workplane. 

 

When selected, Align with the principal editing plane uses the principal 

editing plane when aligning a workplane. When deselected, the 

principal editing plane is ignored when aligning the workplane. 
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Stock model engagement 
There is a new page on the finishing strategy dialogs of Stock 

engagement. 

 

Stock engagement avoids the tool damage that occurs when 

machining excess stock and improves surface finish. It also enables 

you to use higher feed rates as excessive tool engagement is 
eliminated. Machining times are improved as this avoids air cutting 

by removing toolpath segments which machine very little, or no 
material. This uses a stock model and is particularly useful when 

semi-finishing. This option is available for finishing strategies. 

 

Depth of cut - specifies the maximum allowable depth of cut into the 

stock material. 

Toolpath generation 
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 - clicking the Stock depth of cut  button changes the 

Stock depth of cut field to Stock radial depth of cut  and the Stock 

axial depth of cut  field appears. Now you can specify separate 

Stock radial and Stock axial depth of cut values 

. 

 Stock depth of cut - specifies the depth of cut in all directions. 

 Stock radial depth of cut - specifies a radial depth of cut. 

 Stock axial depth of cut - specifies an axial depth of cut. 

Machine stock only - only machines the rest material. Segments of 

the toolpath which cut the rest material are kept. Segments of the 
toolpath which don't cut the rest material are removed.  

Detect material thicker than - the calculation ignores stock material 

thinner than the threshold specified here. This helps to avoid thin 

regions being machined, where the benefit of a second cut is 
negligible. These thin regions can be caused by cusps from the 

previous toolpath. 

Minimum length removed - segments of the toolpath which don't cut 

the rest material and are longer than this value are removed. Short 

segments which don't cut the rest material aren't removed. This 
avoids the generation of fragmented toolpaths and associated air 

moves which would join these segments. 

Stock model - the stock model used to check the Depth of cut (or 

engagement) or Machine stock only. If no stock model is selected, 

then stock model engagement isn't considered. By default, no stock 
is selected. 

For more information see Avoiding machining into unmachined 
stock (see page 45) and Machining stock only (see page 49). 
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Avoiding machining into unmachined stock 

This example shows you how to avoid machining too far into the 

stock material. This prevents tool damage by controlling the depth 
of cut into the stock model. This uses the powerdrill.dgk model in 
the Examples file. 

 

1 Create a block around the pocket. 

 

2 Create a model area clearance toolpath using a 30mm end mill. 

 

3 From the Stock Models context menu, select Create Stock Model. 

4 From the individual stock model context menu, select Apply > 

Active Toolpath Last. 
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5 From the individual stock model context menu, select Calculate. 

 

6 Create a constant Z toolpath with a 10mm end mill. On the Stock 

Engagement page: 

 

a Select a Depth of cut and enter a  of 2.0. 

b Select the Stock Model you have just created. 

c Click Calculate. 
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It is easier to see the toolpath without the stock model. 

 

Looking at the ViewMill simulation: 

 

You can see how the toolpath follows the stock model rather than 

the model. 

If you don't control the stock engagement, the toolpath follows the 

model rather than the stock. 

1 Create a second constant Z toolpath based on this one by 

clicking on . On the Stock Engagement page: 

a Select a Stock Model of none. 
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b Click Calculate. 

 

Looking at the ViewMill simulation: 
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This toolpath generates an excessive depth of cut and tool load 

as it machines around the tight corner leaving the upstand in the 
middle. 

 
 

Machining stock only 

This example shows you how to machine stock only and remove all 
segments that don't remove stock. This minimises cutting time by 
removing unnecessary toolpath segments. It uses the powerdrill.dgk 
model in the Examples file. 
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1 Create a model area clearance toolpath and stock model as 

explained in steps 1 - 5 in Avoiding machining into unmachined 
stock (see page 45). 

 

2 Create a constant Z toolpath with a 20mm end mill. On the Stock 

Engagement page: 

 

a Select Machine stock only. 

b Enter a Detect material thicker than of 1.5. 

c Enter a Minimum length removed of 5.0. 

d Select the Stock Model you have just created. 

e Click Calculate. 
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It is easier to see the toolpath without the stock model. 

 

Looking at the ViewMill simulation: 

 

You can see how the toolpath only machines areas where there 

was stock rather than the whole model. 

If you don't control the stock engagement, the toolpath follows the 

model rather than the stock. 

1 Create a second constant Z toolpath based on this one by 

clicking on . On the Stock Engagement page: 

a Select a Stock Model of none. 
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b Click Calculate. 

 

Looking at the ViewMill simulation: 

 

This toolpath machines areas that aren't really necessary and 

therefore elongates machining times. 
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3D limiting of toolpaths 
Limiting toolpaths to a 3D boundary uses a new algorithm and 
produces much better results. 

 Toolpaths are now prevented from dropping below the boundary. 

 Toolpaths no longer stop short, or extend beyond the boundary 

edge in sharp corners. 

 2D limiting is used when 3D limiting isn't applicable, even if this 

is for a limited portion of the toolpath. 
 

Fixed tool axis angles 

There is a new Fixed Angle frame on the Tool Axis dialog . 

 

The Fixed Angle frame fixes the tool axis azimuth or elevation angle 

to a specified value after the orientation has been calculated using 
the primary definition. This fixes one rotational axis of a machine 

tool wherever possible, giving an improved surface finish and 
increases the overall feed rate by reducing acceleration and 

deceleration. The locked axis is only overridden to avoid a collision 
and to ensure the tool stays on the part. 
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 Fixed Angle is available for all tool axis definitions except for 

those with a Tool axis of Fixed Direction and Automatic. 

Fixed angle - determines whether you are fixing the Azimuth or 
Elevation angle. 

The effect of this option is visible when you select Draw Tool Axes 

 on the Toolpath toolbar. 

A Tool axis of Vertical and a Fixed Angle of None gives: 

 

A Tool axis of Vertical and a Fixed Elevation Angle of 45  gives: 

 

 Angle - the angle of the fixed tool axis. 

 Automatic collision avoidance and tool axis limits can override 

the angle specified here. 

Override toolpath workplane - a different workplane to the workplane 

used to generate the toolpath is used to define elevation and 

azimuth. 
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Workplane - the workplane used when fixing the tool axis angle. If 

no workplane is selected, the global coordinate system is used. This 
is the same workplane used for tool axis smoothing. 

The effect of this option is visible when you select Draw Tool Axes 

 on the Toolpath toolbar. 

 Select a Tool axis of Vertical. 

 Select a Fixed Elevation Angle of 0 . 

 Deselected Override toolpath workplane gives: 

 

 Select a Tool axis of Vertical. 

 Select a Fixed Elevation Angle of 0 . 

 Select Override toolpath workplane selected. 

 Select a Workplane created by rotating by 30 about the X axis 

gives: 

 

 In this instance, part of the toolpath is removed as otherwise 

the tool would gouge the part. 

 When you use a Tool Axis of Vertical the azimuth is undefined. 

However, to fix the elevation an azimuth is needed. In this 

instance, the azimuth is defined as 90  from the direction of 
travel. Other Tool Axis types have a defined azimuth. 
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Lead feed rates 
There is a new page on the strategy dialogs of Lead feed rates. 

 

Using the new Lead feed rates page, you can specify the Ramp lead 

in, Lead in, and Lead out feed rates for lead moves as a factor of the 

cutting feed rate. This enables you to use a slower entry and exit 
feed rate. This reduces the stress on the tool and so increases tool 

life. It also minimises damage to the part, especially when cutting 
brittle materials such as graphite. 

 

For example, if you modify the Lead in feed rate factor to 50%, the 

lead in move will be performed at half the Cutting feed rate. 

 You can also specify factors above 100%. 
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The Ramp lead in references the Plunge feed rate; and the Lead in 

and Lead out references the Cutting feed rate specified in Feeds and 

Speeds. 

 Modifying the factor automatically updates the absolute feed 

rate value. Similarly, modifying the absolute feed rate value 
automatically updates the factor. 

Ramp lead in 

The Ramp lead in feed rate controls the speed of the tool when it 

ramps into the stock. 

% - the factor by which the Ramp lead in feed rate is modified. 

mm/min - the absolute feed rate of the Ramp lead in move.  

Lead in 

The Lead in feed rate controls the speed of the tool as it approaches 

the stock, before beginning a cutting move. 

% - the factor by which the Lead in feed rate is modified. 

mm/min - the absolute feed rate of the Lead in move.  

Lead out 

The Lead out feed rate controls the speed of the tool after it leaves 

the stock, at the end of a cutting move. 

% - the factor by which the Lead out feed rate is modified. 

mm/min - the absolute feed rate of the Lead out move. 

 If you are using imperial units the mm/min is replaced by 

in/min. 
 

Transform toolpath enhancements 
The toolpath transformation functionality is improved to make it 
easier to use.  

The Toolpath Transform toolbar is displayed when you click  on 
the Toolpath toolbar, or select Edit > Transform from the individual 

toolpath context menu. 

 

Toolpath transformations allows you to move, rotate, or mirror a 

toolpath. You can easily create complex rectangular and circular 
toolpath arrays. PowerMILL displays a preview of the transformation 

which gives a quick visual check before transforming the toolpath.  
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On activating the Transform Toolpath toolbar most of PowerMILL's 

functionality is disabled until you exit from curve editing. This 
includes: 

 the menu bar, 

 most toolbars, 

 explorer's context menus, 

 graphics area's context menus, 

 most normal commands are blocked. 

 Move - transforms the toolpath by the specified coordinates. 

 

 Keep Original - determines whether the entities are copied or 

replaced when transformed. 

 Replace Original - the original entities are replaced with the 

transformed ones. 

 Keep Original - keeps both the original and transformed 

entities. 

No. of Copies - the number of copies you want. 

 Move Origin - when selected, enables you to move the origin 

graphically, by dragging, or by entering coordinates using , , 

or  and  in the Status bar. 

 Finish - accepts the changes and closes the toolbar. 

For more information, see the moving curves example or the 
moving toolpaths example (see page 74). 

 Rotate - rotates the toolpath around the specified axis by the 

selected angle. 

 

 Keep Original - determines whether the entities are copied or 

replaced when transformed. 



 

PowerMILL 2011 What's New Toolpath generation • 59  

 Replace Original - the original entities are replaced with the 

transformed ones. 

 Keep Original - keeps both the original and transformed 

entities. 

No. of Copies - the number of copies you want. 

Angle - the required rotation angle in degrees. 

 Reposition Rotation Axis - when selected, enables you to move 

the origin of the rotation axis either graphically or by entering 

coordinates using  or  and  in the Status bar. 

 Finish - accepts the changes and closes the toolbar. 

For more information, see the rotating curves example or the 
rotating toolpaths example (see page 76). 

 Mirror - mirrors the toolpath along one of the principal planes of 

the active workplane or along an arbitrary mirror line. If no 
workplane is active, the mirroring is about the relevant plane of the 

global coordinate system. 

 

 Keep Original - determines whether the entities are copied or 

replaced when transformed. 

 Replace Original - the original entities are replaced with the 

transformed ones. 

 Keep Original - keeps both the original and transformed 

entities. 

 Reverse direction - reverses the direction of the mirrored 

toolpath. 

 Reverse order - reverses the toolpath order. 

 Mirror in XY - mirrors the entity in the XY plane. 

 Mirror in YZ - mirrors the entity in the YZ plane. 

 Mirror in XZ - mirrors the entity in the XZ plane. 

 Mirror in Line (see page 77) - mirrors the entity in a plane 

defined by selecting either an existing line or two points. 
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 Move Origin - when selected, enables you to move the origin 

graphically, by dragging, or by entering coordinates using , , 

or  and  in the Status bar. 

 Finish - accepts the changes and closes the toolbar. 

For more information see Mirroring a toolpath in a line example (see 

page 77). 

 Multiple transform - an easier method of performing multiple 

Moves  or Rotations . 

 

The orientation of the transform is determined by the principal 

working plane , , or , set in the Information toolbar. 

There are two tabs: 

Rectangular (see page 63) - this is similar to using the Move  

option but gives a visual preview of the result, and much improved 

flexibility and control.  

Circular (see page 68) - this is similar to using the Rotate  option 

but gives a visual preview of the result, and much improved 
flexibility and control.  
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 Transform to workplane - moves the toolpath so it is in the same 

place relative to the active workplane as it was to the global 

transform. 

Converts this: 

 

to this: 

 

Where  is the global transform and  is the 

workplane axis. 

 Transform to world - moves the toolpath so it is in the same place 

relative to the global transform as it was to the active workplane. 

Converts this: 

 

to this: 
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Where  is the global transform and  is the 

workplane axis. 

Toolpath ordering - allows you to specify the order of the 

transformed toolpaths in the explorer. There are two options: 

 Toolpath group - keeps the initial toolpath ordering. This is the 

default option. 

 Keep tool change - orders the toolpaths according to their 

tools. This minimises tool changes. 

 If you select  and  then the toolpaths are ordered by 

tool usage within a toolpath group. 

 Undo - reverts to what it was before the last change. You can 

undo all the transformations made since the Transform Toolpath 

toolbar was raised. 

 Redo - reinstates the edit you have just undone. You can redo all 
the transformations made since the Transform Toolpath toolbar was 

raised. 

 Accept Changes - accepts and keeps all the toolpath 

transformations. 

 Cancel Changes - deletes all the toolpath transformations. 
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Multiple transform (toolpath) 

 Multiple transform is an easier method of performing multiple 

Moves  or Rotations  of toolpaths. It is available from the 
Toolpath toolbar or Edit > Transform on the individual toolpath 

context menu. 

 

This works in the same way as  Multiple transform on the Curve 

Editor toolbar (see page 23) except it works on toolpaths rather 

than curves. 

The orientation of the transform is determined by the principal 

working plane , , or , set in the Information toolbar. 

For information on the Circular tab, see Multiple Transform - Circular 

(see page 68). 

The examples use the chainsaw.ige model in the examples file with 

a model rest profile toolpath. 

 Number of rows - either enter a value or use  . 
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This toolpath transform has 3 rows and 4 columns: 

 

 Distance between rows - by default these are the extents of 

the geometry you are transforming. 

 Rotate axis - rotates the transform by 90  in a clockwise direction 

in the principal working plane. 

Converts this: 
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to this: 

 

 Move Origin - when selected, enables you to move the origin 

graphically, by dragging, or by entering coordinates using , , 

or  and  in the Status bar. 

 Distance between columns - by default these are the extents of 

the geometry you are transforming. 

 Number of columns - either enter a value or use  . 

This toolpath transform has 3 rows and 4 columns: 

 

Hollow box - places the duplicated toolpaths around the perimeter of 

the pattern and removes the central ones. 
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Converts this: 

 

to this: 

 

 Sorting - defines the order you will machine the duplicated 

toolpaths. The start point is always the centre point of the original 

toolpath. 
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 Along Y, one way in X - creates a toolpath where the duplicated 

entities are machined in order along the Y direction, one way in X. 

 

 Along Y, two way in X - creates a toolpath where the duplicated 

entities are machined in order along the Y direction, using two-way 
machining in X. 

 

 Along X, one way in Y - creates a toolpath where the duplicated 

entities are machined in order along the X direction, one way in Y. 

 Along X, two way in Y - creates a toolpath where the duplicated 

entities are machined in order along the X direction, using two-way 
machining in Y. 

 Clockwise - creates a toolpath where the duplicated entities are 

machined in a clockwise direction. 
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 Anticlockwise - creates a toolpath where the duplicated entities 

are machined in an anticlockwise direction. 

 

For more information, see Rectangular transform example (see 
page 78). 

 

Multiple Transform - Circular (toolpath) 

The Circular tab on the Multiple Transform dialog creates multiple 
Rotations of toolpaths.  
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This works in the same way as the Circular tab (see page 27) on the 

Multiple transform dialog (see page 23) on the Curve Editor toolbar 

except it works on toolpaths rather than curves. 

The orientation of the transform is determined by the principal 

working plane , , or , set in the Information toolbar. 

 Angle - the angle between elements in the transform. You 
can also use the slider, or specify the Number of elements to 

determine the angle. 

 Angle lock - determines whether the rotation angle is calculated 

automatically or not. 

 Calculated - the values are calculated automatically by 

PowerMILL. This assumes that you want a full circular pattern 
(Angle = 360/Number).  

 Edited - the value is entered by you (or another user). The 

Angle and Number values operate independently. This enables 

you to create a partial circle rather than a full circular pattern. 

  and  work as a toggle.  

 Radius - the radius of the pattern. 

 Radius lock - determines whether the rotation radius is defined 

automatically or not. 

 Calculated - the values are calculated automatically by 

PowerMILL. The radius is the distance from the centre of the 

rotation (defined by ) to the centre of the toolpath. 

 Edited - the value is entered by you (or another user). 

 Clockwise - rotates the transform clockwise by half of the Angle. 
Clicking this updates the Offset angle. 
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Original transform: 

 

Clicking  changes it to: 

 

and updates Offset angle to -45 . 

 Anticlockwise - rotates the transform anticlockwise by half of the 
Angle. Clicking this updates the Offset angle. 

 Move Origin - when selected, enables you to move the origin 

graphically, by dragging, or by entering coordinates using , , 

or  and  in the Status bar. 

 Number - the number of entities in the circular pattern. If 

the angle lock is , then editing this field edits the angle. If the 

angle lock is  then Angle and Number work independently. 

It is best to see how these fields interact by example. If you have: 

 An Angle of 60  

  selected. 
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PowerMILL calculates the Number automatically (it is 6). 

 

If you have: 

 A Number of 5 

  selected. 

PowerMILL calculates the Angle automatically (it is 72 ). 

 

If you have: 

 An Angle of 60  

  selected 

 A Number of 5. 
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PowerMILL calculates a partial circular pattern. 

 

Offset angle - determines the start angle of the transform. 

Offset angle of 0 : 

 

Offset Angle of 20 : 

 

Rotation - determines whether you rotate or move the toolpath 

around the transform. 
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 Rotate and copy: 

 

 Rotate and move: 

 

Centre element - creates an additional copy of toolpath at the centre 

of the circle. 

Centre element selected: 
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Centre element deselected: 

 

Sorting - defines the order in which you will machine the duplicated 

toolpaths. 

 Clockwise - creates a toolpath where the duplicated entities are 

machined in a clockwise direction. 

 Anticlockwise - creates a toolpath where the duplicated entities 

are machined in an anticlockwise direction. 

 

For more information see Circular transform example (see page 80). 
 

Moving toolpaths example 

This example shows you how to move a toolpath. It uses the Keep 

Original  option so that you can easily see the effect of the 

transformation. 
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It uses the Chainsaw.ige model in the Examples folder with a rest 

profile toolpath as the active toolpath. 

 

1 Click the Move  button from the Toolpath Transformation 
toolbar. This displays the Move toolbar. 

 

2 Ensure that  is selected. 

3 Enter a No. of Copies of 2. 

4 Enter the coordinates of 300 0 0 in  on the Status bar 

and press the enter key. This moves and copies the active 

toolpath. 

 

5 Click  on the Toolpath Transform toolbar to accept these 

changes. PowerMILL creates the duplicate toolpaths. 

For more complex examples, see Rectangular transform example 

(see page 78) and Circular transform example (see page 80). 
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Rotating toolpaths example 

This example shows you how to rotate a toolpath. It uses the Keep 

Original  option so that you can easily see the effect of the 

transformation. 

It uses the Blisk_Simple.dgk model in the Examples folder with a 

blade finishing toolpath as the active toolpath. It has the XY face  

as the principal working plane. 

 

1 Click the Rotate  button from the Toolpath Transformation 
toolbar. This displays the Rotate toolbar. 

 

2 Ensure that  is selected. 

3 Enter a No. of Copies of 2. 

4 Click  and enter the coordinates of 0 0 0 in  on the 

Status bar and press the enter key. 

5 Enter an Angle of 20 . This rotates and copies the active toolpath. 

 

6 Click  on the Toolpath Transform toolbar to accept these 

changes. PowerMILL creates the duplicate toolpaths. 
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For more complex examples, see Rectangular transform example 

(see page 78) and Circular transform example (see page 80). 
 

Mirroring a toolpath in a line example 

This example shows you how to mirror a toolpath in a user defined 

line. It uses the Keep Original  option so that you can easily see 

the effect of the transformation. 

It uses the Chainsaw.ige model in the Examples folder with a rest 

profile toolpath as the active toolpath. 

 

1 Click the Mirror  button from the Toolpath Transformation 
toolbar. This displays the Mirror toolbar. 

 

2 Ensure that  is selected. 

3 Click  and click the bottom right-hand corner of the block. 
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4 Click . This mirrors and copies the active toolpath. 

 

5 Click  on the Toolpath Transform toolbar to accept these 

changes. PowerMILL creates the duplicate toolpaths. 
 

Rectangular transform example 

This example shows you how to create multiple moves on a toolpath 

using a rectangular pattern. It uses the Keep Original  option so 

that you can easily see the effect of the transformation. 

It uses the Chainsaw.ige model in the Examples folder with a rest 

profile toolpath as the active toolpath. 
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1 Click the Multiple Transform  button from the Toolpath 

Transformation toolbar. This displays the Multiple transform dialog. 

 

2 In the Rectangular tab enter: 

a a Number of rows of 3. 

b a Distance between rows of 500. 

c a Distance between columns of 300. 

d a Number of columns of 4. 

e Hollow box deselected. 

f Click Accept. 
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3 Click  on the Toolpath Transform toolbar to accept these 

changes. PowerMILL creates the duplicate toolpaths.  
 

Circular transform example 

This example shows you how to create multiple rotations on a 
toolpath using a circular pattern. 

It uses the Blisk_Simple.dgk model in the Examples folder with a 

blade finishing toolpath as the active toolpath. It has the XY face  

as the principal working plane. 

 

1 Click the Multiple Transform  button from the Toolpath 

Transformation toolbar. This displays the Multiple transform dialog. 

2 Select the Circular tab and enter a Number of 18. 

The toolpaths should be rotated around the centre of the hub, if 
so, go to step 4. If the toolpath isn't rotated about its centre go 

to step 3. 

3 Click  and enter the coordinates of 0 0 0 in  on the 

Status bar and press the enter key. 
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4 Click Accept. 

 

5 Change the principal working plane to the YZ face . 

6 In the Circular tab enter: 

a a Number of 4. 

b a Radius of 600. 

c Click  and enter the coordinates of 0 0 -400 in  on 

the Status bar and press the enter key. 

d Click Accept. 

 

7 Click  on the Toolpath Transform toolbar to accept these 

changes. PowerMILL creates the duplicate toolpaths. 
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Drawing toolpath cutting moves 

There is an additional option of Draw Cutting Moves  on the 

drawing and viewing options  on the 
Toolpath toolbar. 

 Draw Cutting Moves - toggles the drawing of the cutting moves 

for the active toolpath. Not drawing the cutting moves is useful 
when trying to view toolpath leads or links. 

Toolpath with cutting moves, leads and links drawn: 

 

Toolpath cutting moves not drawn: 

 

 The toolpath leads and links are drawn. 
 

Profile cut direction 
Profile area clearance strategies have an additional option of 
Additional profiles on the Cut direction frame.  
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This enables you to have a different cut direction for the final profile 

pass than for all other passes. Previously, all profile passes had the 
same cut direction. 

 

Profile - the cut direction of the final profiling pass. 

Additional profiles - the cut direction of all passes except the final 

profiling pass. 

The affected strategies are: 

 Model Profile, 

 Model Rest Profile, 

 Slice Profile, 

 Feature Set Profile, 

 Feature Set Rest Profile. 
 

Blisk machining enhancements 
Blisk machining can now machine hubs which bend upwards at their 
ends. It is essential that the hub surfaces are correctly oriented as it 

is the outside of the surface that is machined.  

 

In previous versions blisk machining couldn't create toolpaths on 
hubs (or shrouds) that bent upwards towards the rim.  
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General toolpath enhancements 
There are several generic improvements to toolpaths: 

 All machining strategies now use the new-style machining 

strategy dialogs. This is a tabbed dialog where pages are 
selected from the tree in the left hand panel. This is simpler to 

use and provides an easier way to create toolpaths. 

 3D offset, optimised constant Z, parametric offset, and steep and 

shallow finishing strategies can now use automatic collision 
avoidance. 

 The Properties option on the individual toolpath context menu 

displays some information on the cutting move as well as the 
toolpath name and it's extents.  

 

 Pattern finishing now avoids duplicate points eliminating jerky 
movements of the machine tool. 

 Steep and shallow finishing always machine all shallow regions, 
even when the toolpath workplane is different to the block 

workplane. 

 You can now use skim links on embedded pattern toolpaths with 

a negative offset. 

 There are several improvements to corner toolpaths: 

 Corner clearance toolpath segments are no longer generated 
above the block. 

 Improvements to corner finishing and corner clearance 

toolpaths, especially when using end mills and tip radius 
reference tools. 

 Corner finishing removes more small corners and works better 
in deep slots. 

 Corner multi-pencil finishing toolpath produce better results 
and use less memory. 

 You can now limit a corner multi-pencil toolpath to a 3D 
boundary. 

 Constant Z toolpaths have improvements to contact normals. 
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 Undercut constant Z machining has several enhancements: 

 Improved calculation times. 

 Improved handling of complex tool holders. 

 Reduced fragmentation. 

 You can now use a large negative thickness on rest area 

clearance toolpaths. 

 When copying a toolpath which uses a reference pattern, the 

pattern is also copied. 

 Stock model rest area clearance creates better toolpaths. They 

are far less fragmented. 

 Improvements to the tool axis smoothing of embedded pattern  

and surface finishing toolpaths. 

 Swarf machining doesn't move away from the surface you are 

machining. 

 When tapping, you can now create left handed threads. 

The Tapping Cycle type adds an additional item of Left hand for left 

handed threads. 

 

 The list of possible toolpaths to choose as a reference toolpath 

no longer includes the current toolpath, so it isn't possible to 
accidentally make a toolpath reference itself. 

 If you create a workplane from a strategy dialog, it automatically 
becomes the active workplane. 
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Some new parameters are displayed in the Post-Creation Verification 

part of the toolpath tree: 

 

They are: 

 Holder Cutting Moves 

 Holder Leads 

 Holder Links 

 Tool Cutting Moves 

 Tool Leads 

 Tool Links 

 

Toolpath verification 
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There are several user interface improvements: 

 When drawing the cursor as a tool, the tool shank and holder are 
displayed as well as the tool tip (see page 88). 

 To avoid duplication, options now available on the Curve editor 

toolbar are no longer available on the explorer context menus 
(see page 88). 

 To make it easier to visualise the principal editing plane, the 
normal is displayed in a different colour on the active axes (see 

page 89). 
 

Smart Selection 
A new Selection dialog has been added to PowerMILL 2011 that 

enables you to select surfaces to be used within a component 
thickness set by filtering on a project's Model, Colour, and Levels 

and Sets. 

 

User interface 
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When a new component is imported into PowerMILL, the thickness 

preferences are automatically applied to the component. In 
addition, because these selection settings are stored in the toolpath 

template, you can transfer the settings by exporting and importing 
the template into other projects. This enables you to reduce set-up 

and programming times when machining similar components. 

For example, using the Selection dialog, you can select red 

components and assign the colour to a thickness set to be ignored 
while machining. When you export the thickness set and colour 

preferences to a template file and import the template into another 

project, PowerMILL automatically assigns the selection settings to 
any red components in the target project. 

 To select components for a thickness set, click  on the 
Component Thickness dialog. In the Selection dialog, select 

individual model components. 

 To make general selections in a project, from the Models context 

menu, select Select Model Components.... to display the Selection 

dialog. 
 

Displaying the cursor as the tool 
The Draw > Cursor > Tool option now displays the tool shank and 

holder as well as the tool tip. This improves the ability to do a visual 
check of the tool against the part. 

 
 

Context menu options 
To avoid duplication, options now available on the Curve editor 

toolbar are no longer available on the explorer context menus. 
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The Offset   button (see page 16) on the Transformation toolbar 
on the Curve editor toolbar replaces the individual boundary context 

menu options of: 

 Edit > Offset (3D Smooth) 

 Edit > Offset 3D (Round Corners) 

 Edit > Offset 2D (Round Corners) 

 Edit > Offset 3D (Sharp Corners) 

and the individual pattern context menu options of: 

 Edit > Offset 2D (Round Corners) 

 Edit > Offset 2 (Sharp Corners). 
 

Principal working plane enhancements 
To make it easier to visualise the principal editing plane, the normal 
is displayed in a different colour on the active axes. By default, the 

normal to the principal editing plane is cyan. 

 The active axes is the graphic at the bottom left corner of the 

graphics window. 
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You can now change the Orientation Vector Length. This option is 

available on the Options dialog (available from the Tools > Options > 

Toolpaths > Drawing menu. The Orientation Vector Length is displayed 

when you Draw Orientation Vectors . 

 

You are no longer limited to the style of connection moves in an NC 
program when using orientation vectors. 

Cutter compensation settings are kept when a toolpath is 

transformed. 

The default thicknesses are considered when a pattern is dropped. 

 

General enhancements 
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A 
Active axes • 89 
Angle 

Fixed tool axis angle • 53 
Arc • 12 
Arc from three items • 12 
Axes • 89 

B 
Blisk machining • 83 
Block • 39 

Block from reference surfaces • 39 
Boundary outside block • 4 
Changing fillet radius • 13 
Save block • 39 

Block from reference surfaces • 39 
Boundary 

Boundary outside block • 4 
Shallow boundary • 4 

Boundary outside block • 4 

C 
Centre element (curve) • 23 
Centre element (toolpath) • 68 
Changing fillet radius • 13 
Circular transform (curve) • 27 
Circular transform (toolpath) • 63 
Collision avoidance • 84 
Context menus • 88 
Cursor • 88 
Curve editor • 6 

Arc • 12 
Changing fillet radius • 13 
Curve properties • 6 
Editing an arc • 13 
Insert point into curve • 34 
Limit a curve to an intersection • 33 
Line • 6 
Multiple transformation (curves) • 23, 
27 
Offset curve • 16 
Transform curve to global coordinates 
• 6 
Transform curve to workplane • 6 
Transform curves • 6 

Curve properties • 6 
Cutting moves • 82 

D 
Draw cursor • 88 
Draw toolpath cutting moves • 82 
Drop pattern • 6 

E 
Editing an arc • 13 
Embed pattern • 6 

F 
Fillet 

Changing fillet radius • 13 
Fixed tool axis angle • 53 
Flatten pattern • 6 
Form Tool • 35 

Index 
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H 
Holder geometry • 35 
Hollow box (curve) • 23 
Hollow box (toolpath) • 63 

I 
Insert point into curve • 34 

L 
Lead feed rates • 56 
Limit a curve to an intersection • 33 
Line • 6 

M 
Machining stock • 45, 49 
Menus • 88 
Mirror toolpath • 77 
Move toolpath • 74 
Multiple transform (toolpath) • 63, 68 

Centre element (toolpath) • 68 
Circular transform (toolpath) • 63 
Hollow box (toolpath) • 63 
Rectangular transform (toolpath) • 78 

Multiple transformation (curves) • 23, 27 
Centre element (curve) • 23 
Circular transform (curve) • 27 
Hollow box (curve) • 23 
Rectangular transform (circular) • 23 

N 
New strategy dialogs • 84 

O 
Offset curve • 16 
Options 

Orientation vector length • 90 
Orientation vector length • 90 

P 
Pattern 

Drop pattern • 6 

Embed pattern • 6 
Point 

Insert point into curve • 34 
Principal working plane • 89 
Profile cut direction • 82 
Properties 

Curve properties • 6 

R 
Rectangular transform (circular) • 23 
Rectangular transform (toolpath) • 78 
Rotate toolpath • 76 
Routing Tool • 35 

S 
Save block • 39 
Selection • 87 
Shallow boundary • 4 
Shank geometry • 35 
Smart selection • 87 
Stock model engagement • 43 

Machining stock • 45, 49 

T 
Tool • 35 

Form Tool • 35 
Routing Tool • 35 
Tool shank creation • 35 

Tool axis 
Fixed tool axis angle • 53 

Tool database • 38 
Tool holder geometry • 35 
Tool shank creation • 35 
Tool shank geometry • 35 
Toolpath 

Blisk machining • 83 
Collision avoidance • 84 
Lead feed rates • 56 
New strategy dialogs • 84 
Stock model engagement • 43 
Toolpath improvements • 84 
Toolpath properties • 84 

Toolpath properties • 84 
Toolpath verification • 86 
Transform curve to global coordinates • 

6 
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Transform curve to workplane • 6 
Transform curves • 6 

Multiple transformation (curves) • 23, 
27 
Transform curve to global coordinates 
• 6 
Transform curve to workplane • 6 

Transform toolpath • 57 
Mirror toolpath • 77 
Move toolpath • 74 
Multiple transform (toolpath) • 63, 68 
Rotate toolpath • 76 
Transform toolpath to workplane • 57 

Transform toolpath to workplane • 57 

W 
Working plane • 89 
Workplane alignment • 42 
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